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Question Number : 1 Question Id : 2012982411 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
In MS Word 2003, if you click on the multiple pages button available on the Print Previewtoolbar:

Options:
| « Your computer screen will show you all pages of the document side by side.

> % Your computer screen will show you all pages of the document one over the other.
5 % Your computer screen will show you all pages of the document overlapping each other.

4 % Your computer screen will show you all pages of multiple documents stacked separately.

Question Number : 1 Question Id : 2012982411 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: 0
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Question Number : 2 Question Id : 2012982412 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
In MS Word, in the Print dialog box. the Print to File creates

Options:
1 = .Ixt file

> % .doc file

- % .dot file



4  -pmfile

Question Number : 2 Question Id : 2012982412 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Options:

| x bxt IE
5 % -doc WIgel
- w .dot HFer

. & P HIEA

Question Number : 3 Question Id : 2012982413 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
In MS Excel 2016, if the cursor is located at column E and row 15 of a worksheet, the address of the cell will be:

Options:
1 & 15E

5 o E15

= % E:15

Question Number : 3 Question Id : 2012982413 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:

. % 15E

. «» E15

2 % E: 15
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Question Number : 4 Question Id : 2012982414 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical



Correct Marks: 1 WrongMarks: 0
You CANNOT save an Excel 2016 file in a/an format.

Options:
, % PDF

> « PSD
3 % TXT

4 % XML

Question Number : 4 Question Id : 2012982414 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Options:
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Question Number : 5 Question Id : 2012982415 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Which cable has foil shielding over twisted wires?

Options:
, + Shielded Twisted Pair (STP) cable

- % Coaxial cable

5 = Single-mode fibre optic cable

4 % Multi-mode fibre optic cable

Question Number : 5 Question Id : 2012982415 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Question Number : 6 Question Id : 2012982416 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

A collection of related information sorted and dealt with as a unit is a:
Options:

1 = Disk

-~ % Data

3 « File

5

4 # Floppy

Question Number : 6 Question Id : 2012982416 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 7 Question Id : 2012982417 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

MS Word 2007 allows creation of type of document by default.
Options:

1 « .doc
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Question Number : 7 Question Id : 2012982417 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:
1 « .doc

5 % wpf

4 ® .dot

Question Number : 8 Question Id : 2012982418 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

Using Print Preview is useful when you want to:
Options:

1 % Colour the document

-

Save the document

ra
®

Delete the document

L
®

4 + Print the document

Question Number : 8 Question Id : 2012982418 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 9 Question Id : 2012982419 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
A is a collection of computers and devices connected together.

Options:
1 % Protocol
> % Memory card

3 « Network

, » Central processing unit

Question Number : 9 Question Id : 2012982419 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 10 Question Id : 2012982420 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Which of these was the first network?

Options:
, % CSNET

> % NFSNET

5 % ANSNET



4 « ARPANET

Question Number : 10 Question Id : 2012982420 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Options:

., %= CSNET

. # NFSNET
5 % ANSNET

4 v+ ARPANET

Question Number : 11 Question Id : 2012982421 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

Address of the first cell in an Excel worksheet is:
Options:

1 ® 1

2_-&3?&.
3. ¢ Al

4 % 1A

Question Number : 11 Question Id : 2012982421 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: 0
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Options:
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Question Number : 12 Question Id : 2012982422 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0



In Excel, the intersection of a row and column is called a:

Options:
1 ® square

> # cubicle
3 « cell

4 % worksheet

Question Number : 12 Question Id : 2012982422 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 13 Question Id : 2012982423 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
An 8-bit address code can select

Options:

, % 8 locations in memory

3 1 { 4
5 o 236 locations in memory
5 » 05,536 locations in memory

4 % 131,072 locations in memory

Question Number : 13 Question Id : 2012982423 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Question Number : 14 Question Id : 2012982424 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
By using which feature can you insert the contents of clipboard as text without any formatting?

Options:
1 % Insert

-, % Copy

-  Paste special

4 % Paste

Question Number : 14 Question Id : 2012982424 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:

1 # Insert

. = Copy
-  Paste special

4 % Paste

Question Number : 15 Question Id : 2012982425 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

is a simple way to capture the ornate look of an old book or manuscript.
Options:
1 % Format



5 of Drop cap
z #® Review

4 % Layout

Question Number : 15 Question Id : 2012982425 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:
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Question Number : 16 Question Id : 2012982426 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
In which mode does the existing text NOT move to the right when you type new text in a word document?

Options:
1 % Insert

5 of Over type
z ® Edit

4 % Select

Question Number : 16 Question Id : 2012982426 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: 0
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Question Number : 17 Question Id : 2012982427 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
What is the key combination to move one word to the right in MS Power Point?

Options:

1 ® CTRL +SHIFT +<

> o CTRL +RIGHT ARROW
= % CTRL + SHIFT +=>

4 % SHIFT +<

Question Number : 17 Question Id : 2012982427 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:

, % CTRL + SHIFT + <
> v CTRL + RIGHT ARROW
- » CTRL + SHIFT + >

4 % SHIFT + <

Question Number : 18 Question Id : 2012982428 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
In MS Power Point. when a task pane is active, what is the key combination to select the next or previous option in the

task pane, respectively?
Options:

1 % ALT +TAB

~ o SHIFT + TAB
= % CILR +TAB

4 » HOME + TAB



Question Number : 18 Question Id : 2012982428 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:

, % ALT + TAB
., » SHIFT + TAB
. « CTLR + TAB

. » HOME + TAB

Question Number : 19 Question Id : 2012982429 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
What is the key combination to mute the sound in MS Power Point?

Options:
1w ALTH+U
> % ALT+M

5 % ALT+S+0

4 % ALT+U+S

Question Number : 19 Question Id : 2012982429 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:

. v ALT + U
, % ALT + M
2% ALT + S + 0

L% ALT+U+ S

Question Number : 20 Question Id : 2012982430 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0



Which one of the following is the most important or powerful computer in a network?

Options:
1 « Network Server

> % Client Server

5 » Desktop

4 % Mainframe Computer

Question Number : 20 Question Id : 2012982430 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Question Number : 21 Question Id : 2012982431 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

‘Which of the following events is in the right order for ‘the data series that you want to plot on a secondary vertical axis’
in MS Excel?
Options:

1.+

Chart Tools = Format > Current Selection > Format Selection > Series Options = Plot series On = Secondary Axis
2 %

Chart Tools = Format = Current Selection = Series Options > Format Selection > Plot series On = Secondary Axis

g»
Chart Tools = Format > Current Selection > Format Selection = Plot series On = Series Options = Secondary Axis

4 ®
Chart Tools = Format = Secondary Axis > Current Selection > Series Options = Format Selection = Plot series On

Question Number : 21 Question Id : 2012982431 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 22 Question Id : 2012982432 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

Which of the following events is in the right order to ‘Change the chart type of a data series’ in MS Excel?
Options:

; w Chart Tools = Design > change Chart Type = Type

-  Chart Tools > Design > Type > change Chart Type

- % Chart Tools > Type > Design > change Chart Type

4, % Design > Chart Tools > change Chart Type > Type

Question Number : 22 Question Id : 2012982432 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

AT & ¥ FiF @ geaT MS Excel &, ‘ST 4T % I F TR & IEaa F T & T F7
a8?

Options:

| % TE & 3T > BAEA > A F 9FR A IWNEGT > THR

L4

, » TE & TR > BARST > §FR > A F FFRK # INTA

L x TIE & ITROT > FFR > BT > 9 F v # N



, » BT > AE F 30T > ARE F TR H IEGdT > TER

Question Number : 23 Question Id : 2012982433 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Chart object inserted into a worksheet is referred to as:

Options:
1 + Embedded chart

> % Stock chart
= % Surface chart

4 % 3-D chart

Question Number : 23 Question Id : 2012982433 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 24 Question Id : 2012982434 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
When information from an Excel object is embedded in Word. then that information:

Options:
, ® can be deleted, if source file 1s modified

-~ % can be copied. if source file is modified

- % canbe updated, if source file is modified

4 « remains the same, if source file is modified



Question Number : 24 Question Id : 2012982434 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 25 Question Id : 2012982435 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
When you use Chart in PowerPoint Presentation, allows you to update chart by making changes in the spread

sheet in MS Excel.
Options:
;& link

> # delete

- % update

Question Number : 25 Question Id : 2012982435 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 26 Question Id : 2012982436 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

The users of may encounter bomb errors when the computer.
Options:

. w Android. operating

-  Macintosh, operating

- % Unix. operating

4 % MS-OS, formatting

Question Number : 26 Question Id : 2012982436 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:

. % Android, 3TRTET (operating)

, « Macintosh, 3ToRfET (operating)
. % Unix, 3TfET (operating)

, % MS-0S, BRATET (formatting)

Question Number : 27 Question Id : 2012982437 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
In Apple computers. BOMB icon is a type of:

Options:
| % Program

> # Protocol
= « Error

4 % Method

Question Number : 27 Question Id : 2012982437 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:
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Question Number : 28 Question Id : 2012982438 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

To smoothen the edges of screen fonts. which option from Desktop setting is used?
Options:

1 # Transition effects

.

> « Screen fonts

Shadow under menu

L
u

Hide underlined letters

o
®

Question Number : 28 Question Id : 2012982438 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 29 Question Id : 2012982439 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
is the output of encryption algorithm.

Options:



, « Ciphertext

> % Abnormal
% % Plaintext

4 » English

Question Number : 29 Question Id : 2012982439 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 30 Question Id : 2012982440 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
Bit Torrent File has file format.

Options:
1« .torrent

> % .bitorrent
= % .bittorent

4 R .bit

Question Number : 30 Question Id : 2012982440 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Options:

1 « .torrent




- % .bitorrent
= # .bittorent

Question Number : 31 Question Id : 2012982441 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Which of the following is NOT a component of OS?

Options:
| % Process Management

» % /O Management

5  Security and Privacy

4 % Memory Management

Question Number : 31 Question Id : 2012982441 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 32 Question Id : 2012982442 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
Which of the following is NOT included in the test plan document of test documentation?

Options:
1 % Testitem

- « Quality plans



= % Schedule and deadline

4 % That which is not to be tested

Question Number : 32 Question Id : 2012982442 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Question Number : 33 Question Id : 2012982443 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
A Browser allows you to see and explore information on the

Options:
1 « Web

> # Software
- = Application

4 % System

Question Number : 33 Question Id : 2012982443 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: 0
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Question Number : 34 Question Id : 2012982444 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
What happens when you click on ‘Open with’ to download a file?

Options:
, « Fileis downloaded and opened using default program.

- » File is downloaded only.
- » Fileis saved to temp folder.

4 = File is opened without downloading.

Question Number : 34 Question Id : 2012982444 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Question Number : 35 Question Id : 2012982445 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

In a 2-wire modem:

Options:

| « Same pair of wire is used for incoming and outgoing carriers.

- % Two ports are used.
« two connections are possible at a time.

3

4, % two different frequencies are used.



Question Number : 35 Question Id : 2012982445 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 36 Question Id : 2012982446 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
DSL stands for:

Options:

1 # Data Service Line

-~ % Dynamic Subscriber Line
5 % Digital Service Line

4 Digital Subscriber Line

Question Number : 36 Question Id : 2012982446 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Options:
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Question Number : 37 Question Id : 2012982447 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Which of the following internet services DOES NOT get affected by your location and offers speeds of up to 15 Mbps

for downloading and uploading?
Options:
1 # Cable broadband

-  Fiber optic service
2 % ADSL

4 % Satellite

Question Number : 37 Question Id : 2012982447 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:
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Question Number : 38 Question Id : 2012982448 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Among the two types of DSL. Asymmetric DSL is than Symmetric DSL.

Options:

, « cheaper

- ® secure
- # costlier

4 % better

Question Number : 38 Question Id : 2012982448 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 39 Question Id : 2012982449 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
Cable Broadband was developed:

Options:
, % toprovide uninterrupted internet.

> # for a social cause.

5 # toprovide free access.

4 « toprovide reliable TV service to communities.

Question Number : 39 Question Id : 2012982449 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 40 Question Id : 2012982450 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Which of the following is the advantage of DSL over other broadband internet services?



Options:
; w Ithas unbeatable upload and download speeds.

> % It can accommodate unlimited number of users.
5 u Itisfreely available.

4 « You have more than one DSL provider that you can choose from.

Question Number : 40 Question Id : 2012982450 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 41 Question Id : 2012982451 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Instructions: Refer to the example and answer the question.

Example: http.//www.example.com/Bar.html#sectionl to http.//www.example.com/Bar.html
Question: Removing the fragment is the process of:

Options:
1 « URL normalisation

5 % URL support
- % URL balancing

4 % URL modification

Question Number : 41 Question Id : 2012982451 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Options:
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Question Number : 42 Question Id : 2012982452 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
A first-line is the most common way to signal the start of a new paragraph.

Options:
, w align

- % centre
3 « indent

4 #% shift

Question Number : 42 Question Id : 2012982452 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 43 Question Id : 2012982453 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
A dual-layer Blu-Ray disc can store up to of data.

Options:
, % 51GB

> % 52GB
- % 49GB

4« 50GB

Question Number : 43 Question Id : 2012982453 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Options:

. % 51 GB
, » 52 GB
.« 49 GB

4+ D0 GB

Question Number : 44 Question Id : 2012982454 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Where does the CPU store the variables it is working on?

Options:

1 Registers

> % RAM

2 % ROM

4 % Flash

Question Number : 44 Question Id : 2012982454 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:




, « Registers
> & RAM
3 & ROM

4 # Flash

Question Number : 45 Question Id : 2012982455 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
DMA stands for:

Options:

, % Digital Memory Access

5 Direct Memory Access

3 % Distinct Memory Allocation

, = Direct Memory Allocation

Question Number : 45 Question Id : 2012982455 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:
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®

1

. » Direct Memory Access (STR# AANT THAH)
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Question Number : 46 Question Id : 2012982456 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
Which keys are used to switch from the current window to the next window?

Options:
1 % ALT +~RIGHT ARROW



> % ARROWKEY
s % CTRLKEY

4 v ALT+TAB

Question Number : 46 Question Id : 2012982456 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Options:

, % ALT + RIGHT ARROW
, » ARROW KEY
; # CTRL KEY

. v ALT + TAB

Question Number : 47 Question Id : 2012982457 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Which of the below types of keys is ‘Ctrl’ and *Shift*?
Options:

, = Adjustment

5 % Function
= « Modifier

4% Alphanumeric

Question Number : 47 Question Id : 2012982457 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:

. » Adjustment (TSSTFCHE)

, » Function (%)



. » Modifier (FIf3HRR)

, » Alphanumeric (HEHIFANF)

Question Number : 48 Question Id : 2012982458 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Bluetooth is an example of:

Options:
, « Dpersonal area network

> # local area network
5 w Virtual private network

4 % enterprise network

Question Number : 48 Question Id : 2012982458 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Question Number : 49 Question Id : 2012982459 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

A card reader is a data input device that reads data from a card-shaped
Options:

1 % slot

> % Virtual memory

-  Sstorage medium



4 % internet medium

Question Number : 49 Question Id : 2012982459 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: 0
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Question Number : 50 Question Id : 2012982460 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
The communication between a card and a card reader takes place through direct coupling. This leads to:

Options:
, w Portability

, w Reliability

o  Better speed

, » Efficiency

Question Number : 50 Question Id : 2012982460 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 51 Question Id : 2012982461 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

Digital cameras share an optical system, with a/an having a variable diaphragm to focus light onto an image
pickup device.

Options:

; w Optical sensor

> % Adjusting glass

= « Lens

4 % Image sensor

Question Number : 51 Question Id : 2012982461 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:

, = Optical sensor

- » Adjusting glass

z « Lens

4 » Image sensor

Question Number : 52 Question Id : 2012982462 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
A webcam is connected by a:

Options:

5 ¥ USB port
% Parallel 36 pin port

2

4 % VGA port

Question Number : 52 Question Id : 2012982462 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical



Correct Marks: 1 WrongMarks: 0
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Read the given passage and answer the questions.
A young man stood before the MD of a large company.

The Managing Director read his resume. The candidate had an excellent
academic record all through.

The MD asked, “Have you ever been offered scholarship in school?”
“None.” answered the youth.
"Did your father pay your school fees?"

"My father died when I was one year old. It was my mother who paid my
school fees."

“Where did your mother work?" asked the MD.

"She worked as a clothes cleaner.”

The MD asked him to show his hands. They were smooth and perfect.
Then he asked, "Have you ever helped your mother?”

"Never. My mother always wanted me to study and do well."

"So today, when you go back, clean her hands. Then see me tomorrow
morning."

When he reached home, the young man asked his mother to let him clean
her hands. She was confused but happy. She showed her hands to him.

As he began cleaning her hands, a tear fell from his eyes. He realised for
the first time that her hands were wrinkled and bruised. Some bruises were
so painful that she shivered when he poured water to clean them.

He understood the price she had to pay for his studies. He then washed all
the clothes.

That night, they talked for a long time.

Next morning, when he reached office, the MD noticed tears in his eyes.
"Can you tell me what did you and learn yesterday?"

"I cleaned my mother's hands and washed all the clothes."
“How did you feel?”

“I learnt what appreciation is. Without my mother, I couldn’t have been
successful. I learnt how difficult it is to get something done and the value
of family relationship.”

"This is what I am looking for in my manager. I want a manager who can
appreciate help of others, who knows the sufferings of others and someone
for whom money is not the only goal in life. You are hired.”



Sub questions

Question Number : 53 Question Id : 2012982464 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
The MD was looking for a manager who:

Options:
, % Wwas smart and expert at his job.

5 o had qualities of head and heart.

- » respected his mother.

, % Wwas academically excellent.

Question Number : 54 Question Id : 2012982465 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
The MD asked him to do something rare. What was it?

Options:

, » Tocome the next day on time

- % To wash his clothes at home
= « 10 wash his mother’s hands

4 % To sit and talk to his mother

Question Number : 55 Question Id : 2012982466 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Which of the following was an unforgettable experience

for the young boy?
Options:
, w Difficulty in getting a job after struggling so much

> « Realisation about the sacrifices his mother had made
= % The hard work he had done all his life

4 % The promises he had made to himself and to his mother

Question Number : 56 Question Id : 2012982467 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical



Correct Marks: 1 WrongMarks: 0

Complete the following sentence by choosing the
most appropriate ending.

From the passage we can infer that the company did
well because the management believed in

Options:

, « treating each worker with dignity

-~ % paying high wages and salaries
- u selecting executives very carefully

, % providing all utilities and facilities

Question Number : 57 Question Id : 2012982468 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
The most appropriate title for the passage could be:

Options:
,  Good Leadership

- % Leaders Can Be Groomed

- % [Ihe Art of Hiring and Firing

4 % On Selecting a Good Leader

Question Id : 2012982463 Question Type: COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions: No

Question Numbers: (53t057)
Cuestion Label © Comprehension
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Sub questions

Question Number : 53 Question Id : 2012982464 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Correct Marks: 1 Wrong Marks: O
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Question Number : 55 Question Id : 2012982466 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 56 Question Id : 2012982467 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Question Number : 57 Question Id : 2012982468 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Question Number : 58 Question Id : 2012982469 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Sonika invested an amount of € 5800 for 2 years. At what rate of compound interest will she get an amount of ¥ 594.50

at the end of two years?
Options:
1 5 pcpa

, % 4pepa
5 % 6pcpa

4 % 8pcpa

Question Number : 58 Question Id : 2012982469 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Options:
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Question Number : 59 Question Id : 2012982470 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O



‘What approximate value will come in place of the question mark (?) in the

following question? (‘You are not expected to calculate exact value)

1559.95 — 7.99 x 24.96 —?* = 1154

Options:
1 v 14

Question Number : 59 Question Id : 2012982470 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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1559.95 - 7.99 x 24.96 - 72 = 1154
Options:

1. 14

Question Number : 60 Question Id : 2012982471 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

50 term of the series 1+ 5+ 12 - 22+ 35+ ... is:
Options:
. % 3600

2. ® 35.' !



Question Number : 60 Question Id : 2012982471 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
gEger 1 + 5 + 12 + 22 + 35 + .. &r 509 9g 7 grem?

Options:

. % 3600
. 3577
- = 3700

. v 3725

Question Number : 61 Question Id : 2012982472 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
The ratio of the adjacent angles of a parallelogram is 7 : 8. Also, the ratio of the angles of quadrilateral is 5:6: 7 : 12.

What is the sum of the smaller angle of the parallelogram and the second largest angle of the quadrilateral?
Options:

. v 168°
5 % 228
=z ® 156

4% 224

Question Number : 61 Question Id : 2012982472 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:

| « 168

5 x 228
T B 156
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Question Number : 62 Question Id : 2012982473 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0



Study the given information carefully to answer the questions that follow:

A basket contains 4 red. 5 blue and 3 green marbles.

It two marbles are drawn at random, what is the probability that both are red?

Options:

3
7

| =2

Question Number : 62 Question Id : 2012982473 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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3
7

B | =2
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What should come in place of the question mark (?) in the following number series?

9 19 40 83 7?7 345 696
Options:
;% 162

5 o 170
s % 175

4 % 166
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3 19 40 83 7 345 696

Options:

| % 162

5 & 170

2 % 175

4 % 166
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Question Number : 64 Question Id : 2012982475 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks: 1 WrongMarks: 0
Study the following arrangement carefully and answer the question given below:

WIR%4JE#7TMT219BH3AS9FQSDGG6USP
What should come in place of the question mark in the following series on the basis of the above arrangement?

R4# M2B 385Q *?

Options:
1% 5GU

> % D6S
=% 5GS

4« D6P
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Options:

, #5GU

,xDB6S
2% 5GS

4+ DGBP
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Study the following letter-number sequence to answer the question below:

E&LGBDMANKHZ2ZACZSV3IF1IJLOQSPR

If the letters/numbers only from M to L are written in the reverse order and other letters/numbers are kept unaltered.

then which letter will be the third to the right of the 171 fetter/number from the right?

Options:
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Options:

1 #® A
- & C
o ® S

4 Z
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Which of the following words will come second if all of them are arranged alphabetically as in an English dictionary?

Options:
1 « Heaven

> % Hillock
- % Hawker

4 ® Hilt

Question Number : 66 Question Id : 2012982477 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
IR o fedr T §1 IS Welr el v IS ey F IWFEN AUNGHEA H cgareud fhdT ST g
af gEY T 9T i AT 9Meq HAI?

Options:




1 « Heaven
- % Hillock
= % Hawker

. % Hilt
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Which of the following words will come third if all of them are arranged alphabetically as in an English dictionary?

Options:
; » Cough

> o Council
z % Couch

4 % Count

Question Number : 67 Question Id : 2012982478 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
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Options:

% Cough

1
> « Council
= % Couch

4 % Count
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If all the letters from A to Z were writtenas A C E G _upto Y, i.e., dropping each alternate letter and leaving blank

space, and then all the blanks were filled in with the remaining letters in reverse order, i.e., AZCXE V...... ending
with B. then how many pairs of letters in the series will be old neighbors from regular alphabetical order?

Options:

1 ® One



> o Two
3 % Three

4 % None
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1, % Teh

s Bl
3_%3%

4 % P AL
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Select the alternative in which the words share the same relationship as shared by the given words.

Hunt : Pleasure : Panic
Options:
1 % Death : Disease : Germs

u

> % Game : Match : Win
3 « Thefl : Gain : Loss

Rain : Cloud : Flood

o
®
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Single Line Question Option : No Option Orientation : Vertical
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Which is the official language of West African Development Bank?

Options:
1 % Arabic

> « French

5 % Portuguese

4 w English
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Options:
1 % Arabic

- « French

- % Portuguese

4 % English

Question Number : 71 Question Id : 2012982482 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
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The XXIV Olympic Games were held in the year:

Options:
| ® 1986

5 o 1988
s % 1984

4 % None of the given options

Question Number : 71 Question Id : 2012982482 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
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Options:

= 1986
. » 1988

5 % 1984
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Continents have drifted apart because of:
Options:

, % Volcanic eruptions



> « Tectonic activities

- » Folding and faulting of rocks

4 % DBoth volcanic and tectonic activities
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Options:

Volcanic eruptions (SaTemHar BFee)

1 ®

, » Tectonic activities (cFerfares arfafaferm)
5 % Folding and faulting of rocks (IgTAT T Yk sk ,

, » Both Volcanic and Tectonic activities (SETenHET 3R FEafaes g afafafaan)
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Correct Marks: 1 WrongMarks: 0
Match List-I (landforms) with list-II (processes) and select the correct answer.

List-I List-IT
A. Nick point 1. Karst
B. Sink hole 2. Fluvial
C. Point bar 3. Plantation
D. Accordant summit 4. Rejuvenation

Options:
. % A-3.B-2.C-1,D-4

. » A-4.B-1,C-2.D-3

5 # A-3,B-1,C-2, D4

, # A4,B-2.C-1,D-3

Question Number : 73 Question Id : 2012982484 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks: 1 WrongMarks: 0
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Options:

. » A3 B2, C1,D4
, v A4, B-1, C2, D3
% A, B1, C2, D4

ou AL B2, 61, B3
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Correct Marks: 1 WrongMarks: 0
Match List-I (Mineral) with List-II (Place) and select the correct answer.

List-I List-IT
A. Mica 1. Chindwara
B. Diamond 2. Bellary
C. Manganese 3. Panna
D. Copper 4. Hazaribag
Options:

, « A-1,B-2,C-3.D-4
, « A-1,B-3.C-2,D-4
v A-4,B-3.C-2.D-1

. % A-4,B-2,C-3,D-1
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A. HHF 1. 5aaEr
B. gRr 2. Swelrdr
C. &= 3. el
D. greEr 4. gAT{EET
Options:
, 2 A-1,B-2C-3D-4
,%x A-1,B-3C-2D-4

AL B8 8- 2 B

4% A-4B-2C-3D-1
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The implementation of Jawahar Rozgar Yojana rests with:

Options:
, « Gram Panchayat

> # District Collector
= % State Government

4 # Union Government

Question Number : 75 Question Id : 2012982486 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
L
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Options:

, » Gram panchayat (ITH T=1Iq)

, » District Collector (fSrem Fererex)



5 » State Government (I=F TIFR)

4 » Union Government (T TFR)
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The carnival of Venice is cne of the most famous carnivals around the world, and a charming characteristic of
the city. [t5 origins are centuries old, and it still attracts thousands of tourists each year to admire the
surmptuous costumes and masks parading in the streets. Creating masks is not just an art in Venice, but also a
tradition dating back hundreds of years in the past. The carnival became internationally farmous and
prestigious in the 18th century, when it reached its widest farme. It was in this period that the writer Casanova
spent his life in Venice betweerl wild parties and love affairs. Wearing masks and costurmes rmade it possible
for people to hide any differences of class or status. At the end of the century, the tradition of wearing masks
was forbidder, and the carnival survived only in some islands of the lagoon. It was only in 1979 that the
ancient tradition was restored, in the form still seen today. The magic of carnival gives an enchanted
atmosphere to Venice. Masked people fill the streets with smiles and laughter, and several events are organized
all around the city. The carnival usually lasts a couple of weeks, but the most important days are those
betweeerl the last Thursday and the very last Tuesday. Howewver, the weelends are usually the privileged tirme
for tourists and visitors. On the last Sunday and last Tuesday of carnival, a big wooden stage hosts the award
ceremony of the best masked costurme. It is elected after several parades that take place during the central
daws of the festival. This stage is also the theater of different plays, where traditional masked characters
interpret Comuc adventures. One can also participate in the suwmptuous masked parties in the 135th century
Style, organized in ancient Yenetian buildings.
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